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The Geneva applicator, a new brachytherapy applicator for 
treatment of gynecological malignancies, was released in 2020.1-2  

This novel applicator replaces the Utrecht applicator and 
several other applicators, and aims at offering a versatile option 
that complements the Venezia applicator in the spectrum of 
gynecological applications. 

Before clinical introduction of a new applicator, the responsible 
medical physicist should perform a set of commissioning 
measurements aimed at verifying proper functioning of the 
device. Most importantly, accurate dose delivery is verified. Next, 
measurements can reveal possible manufacturing defects in the 
applicator, and it helps the physicist familiarize themselves with 
the equipment. The results of the commissioning measurements 
should be appropriately documented in a quality system, meeting 
hospital and local regulations and guidelines, e.g., the EU Medical 
Device Regulations.3 
 
Several reports have been published describing specific 
measurements for brachytherapy equipment, notably ESTRO 
booklet no. 84 and, more recently, report 30 of the Netherlands 
Commission on Radiation Dosimetry.5 Nevertheless, in practice, 
the adoption of various commissioning measurements varies 
greatly between centers.6 Potential reasons for this variation 
are differences in clinical practice and in resources for doing 
commissioning measurements.  
 
The aim of this white paper is to offer a guideline for 
commissioning that enables users worldwide to introduce the 
Geneva applicator into clinical practice swiftly, yet with high 
and reproducible quality that is independent of the operator 
and resources of the hospital. This guideline might save Geneva 
users time in devising, describing and executing commissioning 
methods for the applicator.

Introduction
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Scope
This white paper provides users of the Geneva applicator 
with a detailed but practical set of instructions for 
performing commissioning measurements of the 
applicator. We have defined a set of measurements for 
the following three relevant parameters, either relevant 
for accurate dose delivery or durability, that we describe 
in more detail in this document:
•	 The distance from the tip to the most distal 

dwell position. This parameter, used during 
reconstruction, determines where sources are 
projected on the anatomy during treatment 
planning. A mismatch between the value used in 
treatment planning, and the actual value, results in 
an error in dose delivery.

•	 Intrauterine tube wall thickness. This parameter 
can vary between applicators due to variations in 
the manufacturing process and is relevant to the 
durability of the applicator.

•	 General inspection. Check whether the length, size and 
angle of tubes and ovoids correspond to the nominal 
values; check whether needle holes are accessible. 

This paper does not discuss other parameters relevant 
to accurate delivery during brachytherapy that are not 
directly related to the Geneva applicator, e.g., CT/MR 
image quality, interstitial needle offset, dose calculation 
in the TPS, transfer tube length, afterloader timer 
accuracy, and source strength. For commissioning 
 
 

measurements of these parameters, the reader is 
referred to the previously mentioned reports.

This white paper is applicable for commissioning 
of the Geneva applicator in combination with 
Flexitron® and microSelectron® afterloaders when 
using Applicator Modeling or manual catheter 
reconstruction in Oncentra Brachy. 
 
In Oncentra Brachy, the Geneva applicator model uses 
the central path (lumen axis) as the source path, as 
opposed to the Venezia applicator model, for which 
a measured source path is provided by Elekta.7 This is 
because the ovoids of the Geneva applicator are less 
curved compared to the Venezia lunar-shaped ovoids. 
It is, however, necessary to check at least the first 
two clinically used source positions in the ovoid tubes 
during commissioning. It is assumed that, when moving 
through intrauterine and ovoid tubes, the source does 
not significantly deviate from the center of the tube.

All described measurements use tooling and 
software that is either generally available in a 
radiotherapy department, or can be acquired at no 
cost (e.g., open-source software). For reproducible 
setup of the applicator items, 3D printed holders 
have been designed and developed in this work 
that can optionally be used in the measurements. 
These holders can be prepared using a 3D printer, 
if available. So-called STL-files (Standard Triangle 
Language) describing the holders have been made 
available online (see Appendix).

Commissioning
Overview

Commissioning measurement

Geneva applicator item Distal dwell position Wall thickness
General inspection

External dimensions Needle accessibility

Intrauterine tubes 30–80 mm √ √ √

Intrauterine tube 0 mm √

Interstitial tube √

Ovoid tubes √

Interstitial ovoid tubes 13 mm √ √ √

Interstitial ovoids 15–40 mm √ √

In Table 1, the various items of the Geneva applicator are listed together with the recommended commissioning 
measurements. The commissioning measurements are described in the following sections.

 
Table 1. Overview of the different applicator items and the recommended commissioning measurement.
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Distal dwell position
The measurement of the distance from the outer 
tip of the tube to the most distal dwell position 
is performed by irradiating a film. To simplify this 
procedure, a 3D printed holder was developed for 
the different intrauterine tubes as well as for the 
standard ovoid tubes. If a 3D printer is not available, 
the individual tubes should be attached to the film 
using tape.

Applicator reconstruction in Oncentra Brachy can 
be done either using Applicator Modeling or manual 
catheter reconstruction. The distance from the outer 
tip to the most distal dwell position for each catheter, 
shown in Figure 1, is fixed and incorporated in the 
Oncentra Brachy applicator library model. In case of 
manual reconstruction, when the outer catheter tip 
is used as the distal catheter reconstruction point, 
the user should enter the distance from the tip (1) 
to the distal dwell position (3) per catheter as an 
offset. Similarly, if the lumen end is used as the distal 
catheter reconstruction point, the distance between 
the points 2 and 3 shall be used as the offset. Of 
course, it is also possible to use the distal marker 
inside each catheter as the distal reconstruction 
point, in which case the offset value shall remain 
0 mm (assuming that the distal marker position 
corresponds to the most distal dwell position). All 
three mentioned points (1–3) are represented in the 
applicator library files as so-called anchor points, 
available during applicator placement, to be applied 
on the images.

 

Materials
•	 Afterloader
•	 Intrauterine and ovoid tubes
•	 Corresponding transfer tubes
•	 3D printed holders or tape
•	 Radiosensitive film (EBT3 or XRQA2)
•	 Permanent marker pen
•	 Scanner suitable for film dosimetry
•	 ImageJ version 1.53e
•	 Microsoft Excel

Preparation
The setup for the measurements is a bit different 
depending on the tubes to be measured and the 
availability of the 3D printed holder. 

 a. Intrauterine tubes 30–80 mm and ovoid tubes  
    using 3D printed holders or tape

First, prepare the 3D printed holder as described in the 
Appendix. Before the measurements, test if the applicator 
tubes can be inserted into the holder and use a dummy 
film to test whether it can be inserted completely.

Two measurements will be done for each item. 
Therefore, cut two pieces of film of minimally 5 cm 
long and as wide as the width of the 3D printed holder 
(12 cm for the intrauterine tubes and 4 cm for the 
ovoid tubes holder). 

Place the film and the applicator tubes in the 3D 
printed holder as shown in Figure 2. For positioning 
the intrauterine tubes, the design provides separate 
channels for all available intrauterine tube lengths. 
We strongly recommend using the proper channels for 
the corresponding tube lengths. Make sure that both 
the tip of the applicator and the edge of the film are 
inserted completely toward the end of the holder. 

 
Figure 1. 
Drawing of the tip of the applicator.8

 
Figure 2. 
Positioning of the intrauterine and ovoid tubes with film  
in the 3D printed holders.
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If the 3D printed holders are not available, this 
setup can be performed by fixing the tubes to the 
treatment table using tape. First, the tubes are 
placed parallel to the table and fixed to the table with 
tape, leaving the distal part of the tube free of tape. 
Then a film is placed horizontally on the table, below 
the tube. In this case, the edge of the film must be 
aligned manually with the tip of the tubes (Figure 3). 

 
 

b. Intrauterine tube 0 mm and interstitial ovoid  
 tubes 13 mm using tape

Since no 3D printed holder was prepared for these items 
yet, the best way to set up the tubes for commissioning is 
with tape. Tightly fix the tubes to the table, with the film 
placed on the table below the applicator, parallel to the 
source path. An example of the setup for the interstitial 
ovoid tubes 13 mm is shown in Figure 4. The edge of the 
film should be aligned manually with the tip of the tubes 
as shown.

Irradiation
Two QA plans should be prepared on the Flexitron 
or microSelectron, the first with one channel for the 
intrauterine tubes and the second with two channels 
for the ovoid tubes. These plans should have two dwell 
positions per channel separated 15 mm from each other. 

•	 Flexitron dwell positions 300 and 285 mm
•	 microSelectron dwell positions 1500 and 1485 mm

The recommended dwell time per position for an Ir-192  
HDR source is 20 seconds for a source strength of 
between 2 and 4.5 cGy h-1 m2.  This can be changed 
depending on the source strength or type of film. 
Irradiate the film with the applicator tubes in the 
holder. Repeat the measurement with a second film to 
increase the accuracy of the measurement and to check 
reproducibility. When removing the film, write down with 
a marker pen which set of irradiation spots corresponds 
to which applicator tube, as indicated in Figure 5.

 
Figure 3. 
Positioning of the intrauterine and ovoid tubes with film on the  
treatment table using tape.

 
Figure 4. 
Setup for the interstitial ovoid tube 13 mm using tape.

 
Figure 5. 
Irradiated film with marks and name of intrauterine tubes.
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Analysis
1.	 Before scanning the film, use a marker to draw 

two dots on the film 15 mm apart from each other 
(Figure 7).

2.	 Scan the film in TIFF format. Pay attention to 
the resolution of the scanner. The recommended 
resolution is 150 dpi.

3.	 Open the scan in ImageJ. It is possible to drag the 
image from the folder in Windows Explorer to the 
ImageJ bar. 

4.	Set the scale/pixel size of the image in pixels/mm 
in Analyze > Set Scale (the pixel size depends 
on the scanner settings). Check the Global box. 
The pixel size can be checked by measuring the 
distance between the two dots (Figure 7). Note: 
depending on the image settings, this might be 
done automatically.

5.	 With the Straight tool, draw a line through the 
centers of the irradiation spots, starting from the 
outside of the film.

6.	Make a profile plot by pressing Analyze > Plot 
profile (Ctrl + K).

7.	 Measure the distance between the edge of the film 
and the first minimum (valley) of the profile, which 
is the distal dwell position, or the center of the first 
irradiation spot.

8.	Measure the second film irradiated and use the 
average value of both measurements as the  
final result. 

 
Figure 6. 
ImageJ scale settings.

 
Figure 7. 
ImageJ line drawing for profile plot.

 
Figure 8. 
ImageJ profile measurement.

Edge film

Distal dwell 
position
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Figure 9. 
Schematic of wall thickness measurement.

 
Figure 11. 
CT slice of three intrauterine tips within the 3D printed holder.

 
Figure 10. 
Positioning of the 3D printed holder with the intrauterine  
tubes on the CT table. The arrows indicate the scan direction.

Tolerance 
The distance from the outer tip of the tube to the 
most distal dwell position should be within 1 mm from 
the values reported in the Geneva user manual,8 
which are also incorporated in the Geneva applicator 
model of Oncentra Brachy (if applicable). If manual 
reconstruction in Oncentra Brachy is used, apply 
the measured value as an offset if you start manual 
catheter reconstruction from the outer tip.

Wall thickness
The wall thickness of the tip of the intrauterine tube 
can be measured to assess the robustness of the tip 
and to gauge intrauterine tube concentricity. This can 
be done by acquiring a CT scan of the intrauterine 
tubes. By using open-source software ImageJ, it is 
possible to fit the outer diameter (3.85 mm) and the 
lumen diameter (2.55 mm) with a circle. The shift 
between the center of both circles is directly related to 
the wall thickness (Figure 9).  

Materials
•	 CT scanner
•	 Intrauterine tubes 30–80 mm
•	 3D printed holder or tape
•	 ImageJ version 1.53e
•	 Microsoft Excel

Preparation

A CT scan of the black tip of the intrauterine tubes 
should be acquired. Place the intrauterine tubes in the 
corresponding 3D printed holder. Align the holder so 
that the intrauterine tubes are perpendicular to the 
scanning plane as shown in Figure 10. Use the alignment 
marks on the holder to center and align it with the laser. 
Limit the FOV and scan length to the size of the holder 
and use thin slices, e.g., 1 mm slice thickness.

Analysis
1.	 Open the CT scan as a sequence in ImageJ  

(File > Import > Image sequence).

2.	 First, scroll through the dataset to visually check 
asymmetry along the entire length of the scanned tips. 

3.	 Scroll to the slice where the thickness should be 
measured. It is recommended to use a slice at the 
level of the holes in the holder, so the black tip is 
surrounded by air and image quality of the tip is 
least affected by the surrounding holder material. 
Note: for larger tip lengths, the holder is designed 
with two holes.

4.	Once the slice is chosen, close the image sequence 
and open only the selected slice to make the 
procedure more efficient.
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5.	 Set the unit length to mm (using Image > 
Properties > Pixel width [units]).  
Note: depending on the image settings,  
this might be done automatically.

6.	 Use the Window Level tool to properly visualize 
the tip of the intrauterine tubes (Image > Adjust 
> Window Level). Levels 50/1200 are usually 
suitable.

7.	 For the next step, it is necessary to increase 
the number of pixels of the image in ImageJ by 
interpolation (Adjust > Size). It is recommended 
to increase it until the pixel width and height are 
equal to 0.02 mm (this can be checked after 
changing the number of pixels using Image > 
Properties) (Figure 12).

8.	 Select the Oval function. 

9.	 Make a circle of 3.85 mm in diameter. Keep Shift 
pressed to draw a circular shape. The size of the 
circle is shown in the menu bar of ImageJ while 
drawing.

10. Drag the circular shape until it corresponds to the 
external contour of the intrauterine tip as shown 
in Figure 13. The Window Level tool can be used to 
facilitate this.

 

11.	 Write down the coordinates of the circle. They can 
be found in Image > Show Info, then scroll to the 
bottom of the window. Note: these coordinates 
correspond to the vertex of the square around this 
circle (further explanation in step 12).

12.	Repeat steps 8 to 11 for the lumen with a circle of 
2.55 mm in diameter (see Figure 14).

13.	Calculate the coordinates of the center of the circle.  
The coordinates obtained from ImageJ correspond 
to the vertex of the square around the circles  
(x1, y1) (see Figure 15).

 
Figure 12. 
ImageJ pixel width settings.

 
Figure 13. 
ImageJ outer surface detection of intrauterine tip.

 
Figure 14. 
ImageJ lumen detection of intrauterine tip.

 
Figure 15. 
ImageJ definition of circle position.



— 9 —

 
Figure 16. 
Oncentra Brachy measure tool to measure the tip angle 
deviation in two directions. A 30-degree intrauterine 
tube with a tip length of 50 mm is shown here.

Therefore, the coordinates of the center of the circle 
(x2, y2) for the external surface can be calculated as:

And the coordinates of the center of the circle (x2, y2) 
for the lumen can be calculated as:

14.	 Calculate the shift between the two coordinates 
using Pythagoras’ Theorem.

15.	 Calculate the minimum wall thickness in mm.

N.B. The nominal wall thickness is 0.65 mm, 
corresponding to the difference between the outer 
radius (1.925 mm) and the lumen radius (1.275 mm). 
This is the case when the lumen is drilled exactly in the 
center of the tip.

Tolerance
The thickness along the whole perimeter should be more 
than 0.47 mm, which is the minimum wall thickness 
required in manufacturing by Elekta.

General inspection
A general inspection of all applicator items is 
necessary to avoid unexpected problems during 
clinical use. The items should be checked visually 
to reveal possible cracks. Furthermore, the external 
dimensions, like the nominal length of the tip of 
the intrauterine tubes and the different ovoid sizes, 
should be checked using a caliper. 

The angle of the intrauterine tube as a whole, as 
well as the tip of the intrauterine tube in the cervical 
stopper, have an allowed angle deviation which 
differs per tip length. The absolute angle tolerance 
parameter is the maximum allowed deviation with 
respect to the nominal tip angle. This can be checked 
by fitting the applicator model on a CT scan of the 
tubes. If applicator modeling is not available, angles 
can be checked in two orthogonal planes using the 
measure tool of Oncentra Brachy (Figure 16). 

The accessibility of the different interstitial items 
(interstitial tube, interstitial ovoid tube and interstitial 
ovoids) should be checked using a guiding tube and 
a 6F Proguide needle to reveal possible obstructions. 
Finally, assembly of all items should be performed 
before clinical use to ensure the mechanical integrity 
of the entire applicator.

Tolerance
The tip length of the intrauterine tubes has an 
allowed margin of ±1 mm. The maximum allowed 
deviation from the nominal tip angle differs per tip 
length and can be found in the Geneva user manual.8
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Summary
Commissioning  
measurement     Materials Analysis  

software Tolerance Frequency

Distal dwell position
Afterloader, 3D printed 
holder or tape, film, 
marker pen, scanner

ImageJ  
v1.53e,  
Microsoft Excel

±1 mm Annually

Wall thickness CT scanner, 3D printed 
holder or tape

ImageJ  
v1.53e,  
Microsoft Excel

0.47 mm  
(lower limit) Before first use

General 
inspection

External 
dimensions Caliper – tip length ±1 mm,

tip angle deviation8 Before first use

Needle  
accessibility

Guiding tube,  
6F Proguide Needle

– – Before first use

Assembling Applicator items – – Before first use
 
Table 2. 
Summary of the recommended commissioning measurements.

References
[1] Press release: https://www.elekta.com/pressreleases/elekta-launches-geneva-brachytherapy

[2] Product brochure: https://www.elekta.com/Geneva-applicator 

[3] Regulation (EU) 2017/745 of the European Parliament and of the Council of 5 April 2017 on medical devices,  
	 http://data.europa.eu/eli/reg/2017/745/2020-04-24 

[4] ESTRO Booklet no. 8: A practical guide to quality control of brachytherapy equipment. (2004) https://www.estro.org/ 
	 ESTRO/media/ESTRO/About/Physics%20booklets/booklet-8-a-practical-guide-to-quality-control-of-brachytherapy- 
	 equipment.pdf 

[5] NCS report 30: Code of Practice for Quality Assurance of Brachytherapy with Ir-192 Afterloaders https://doi.org/10.25030/ 
	 ncs-030 (2018)

[6] Palmer et al. A survey of quality control practices for high dose rate (HDR) and pulsed dose rate (PDR) brachytherapy in  
	 the United Kingdom. J Contemp Brachyther. 2012;4(4):232–40. https://pubmed.ncbi.nlm.nih.gov/23378853/ 

[7] Berger et al. Direct reconstruction of the Vienna applicator on MR images. Radiother Oncol. 2009;93:347–51. 93 (2009)  
	 347–51, https://doi.org/10.1016/j.radonc.2009.07.002 

[8] Geneva Instructions for Use: Document ID 77700610MAN-00 Publication date 2020–02 



— 11 —

 
Table I. 
Details regarding the 3D printed holders.

Appendix: 3D printed holders 
For reproducible setup of the applicator tubes, 3D printed holders have been designed and developed in this work 
that can optionally be used in the measurements. These holders can be printed by users using a common FDM 
(fused deposition modeling) 3D printer that uses PLA (polylactic acid) filament. 

As part of this work, no 3D printed holders were developed yet for the intrauterine tube 0 mm and 13 mm ovoid tubes.  
A creative reader of this paper is invited to model these and make them available along with the others on Thingiverse.

Table I describes where necessary files can be downloaded and gives some advice regarding printing of the holders.

Download location

STL-files that can be processed by a slicing program such as Slic3r or Cura is provided 
on Thingiverse: 
https://www.thingiverse.com/thing:4821285
The original Freecad design is provided via the same location for further modification 
(FCStd-file) if necessary.

Printer type
Any FDM (fused deposition modeling) printer using PLA (polylactic acid) filament. 
Minimum printing size should be 12x1x9 cm (wxdxh). FDM printers are generally avail-
able at hospitals, or at commercial 3D printing services.

Printer settings

Example settings are provided at the download location. Note: when the tip channels are too 
narrow or wide for the tube tips, change the following setting in your slicing software before 
printing to make the channels slightly wider or narrower.
•  Cura: horizontal expansion
•  Slic3r: XY Size Compensation
•  Simplify3D: horizontal size compensation
Please consult the manual of your slicing software for further explanation of these settings.

Further preparation steps

•	 Between the main part of the holder and the film 
clamp, there are a number of grips designed to hold 
the film once inserted. After printing, these can be 
slightly attached to the main part, preventing the 
film from being inserted in the holder completely. 
After printing, carefully pull the film clamp as shown 
at right to detach the grips from the main part.

•	 During the film measurements, both the tips and the 
film need to be inserted completely toward the end 
of the holder (the stopper). Due to temperature  
inhomogeneities of the printer platform, the stopper 
can be slightly curved, decreasing the accuracy of 
measurements. Make sure, directly after printing, 
that the stopper is completely straight (see red line 
in figure at right) by carefully observing the print, 
or inserting a thin object with a straight edge, e.g., 
a dummy film or a sheet of paper. If the stopper is 
indeed curved, the result can be improved by making 
a new print with the holder positioned at a different 
position on the platform.
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